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CHAPTER1 Introduction Topics
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1.1. Introduction
CuttingMaster 4 is aprogram that allows you to output directly fromyourdesign application to acutter.

It consists of twoparts:

TheCut/Plot plug-in that allowsyou to set job properties for the cut job fromwithin your design application and
sends the job to CuttingMaster 4.

The CuttingMaster 4 program that receives the job from the Cut/Plot plug-in and outputs it to the cutter.
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1.2. Software License Agreement
IMPORTANT READCAREFULLY: This Agreement (as definedbelow) is a legal contract between You(asdefined
below) andSA International Inc. for Flexi, PhotoPrint, EnRoute, or PixelBlaster brandedSoftware (asdefined
below).

This Agreement (as definedbelow) sets forth the termsandconditions for licensingof the Software from SA Inter-
national Inc. andYou(asdefinedbelow), and installingandusing the Software. This Agreement applies to any
(i) single-user license; (ii) multi-user license; and (iii) original equipment manufacturer (OEM) or Special Edition
(SE) versions of the Software andotherbrandedorcustomizedversions unless otherwise agreed.

BYOPENINGTHE SEALED PACKAGECONTAININGTHE SOFTWAREORDOWNLOADINGTHE SOFTWARE FROMAN
AUTHORIZEDON-LINE SITE, OROTHERWISE USINGTHE SOFTWARE, YOUAGREE THAT YOUHAVE READ,
UNDERSTAND, ANDAGREE TOBE BOUNDBY THE TERMSOF THISAGREEMENT ANDANYTHIRD PARTY LICENSE
AGREEMENTSREFERRED TOHEREIN, INCLUDINGTHEWARRANTYDISCLAIMERS, LIMITATIONSOF LIABILITY,
JURISDICTION, AND TERMINATION PROVISIONSBELOW. IF YOUDONOT AGREE TOTHE TERMSOF THISAGREEMENT,
DONOT OPEN THE SOFTWARE PACKAGE, INSTALL, ORUSE THE SOFTWARE APPLICATION. RETURN THE SOFTWARE
WITHYOURPURCHASE RECEIPT FORA FULL REFUND. IF YOUPURCHASEDANAUTHORIZEDDOWNLOADABLE
VERSIONOF THIS SOFTWARE, TERMINATE THE DOWNLOADANDYOUWILL NOT BE DEBITED.

DEFINED TERMS

Actsmeans the Export Administration Act of 1979, as amended, and the Export Administration Regulations
issued thereunder.

Agreement means this End-User LicenseAgreement, includingany third-party licensesprovided to SA Inter-
national Inc. for use of the Software.

Intellectual Property Rightsmeans, by way ofexample, but is not limited to, the following: rights in know-how,
trademarks, copyrights, patents, patent applications (including reissues, renewals, continuations, con-
tinuations-in-part, or divisions ofany patent or patent application, as appropriate), trade secrets, instructions,
improvements,modifications, suggestions, proposals, programs, ideas, writings, and the like ofany sort what-
soever, andany embodiment thereof including, but not limited to, computerprograms, documentation,
assembly anddetaileddrawings, plans, specifications, results of technical investigationsand research,
assembly, andpartsmanuals, artwork, software, programming, applets, scripts, designs, andany otherpro-
prietary information ofor in connection with the Software.

Information meansany type ofdataYouprovide to SA International Inc. in any formormanner in connection
with: (i) the purchase of the license to use the Software, (ii) the registration of the license to use the Software; (iii)
in connection with Support Services; or in any other communication between YouandSA International Inc.
arisingout of the use of the Softwarewhetherprovidedby Youor the Software in anymediaandany formnow
known or hereafter existing. By its operation, the Softwaremay provide data to SA International Inc. indicating
the operation ofhardware upon which or in connection with the Softwaremay operate and the status, type,
andusemadeofdisposablematerials in connection with the operation of the Software. Such data shall be
included in the definition of Information.

In Usemeans that the Software is loadedonto either temporary (i.e., RAM) orpermanent non-portable
memory (e.g., aharddisk, aCD-ROMorother storagedevice) for that Workstation or otherpersonal computer.

Materialsmeansany applicable, associateddocumentation for use in connection with the Software as
providedby SA International Inc. in anymedium such as, by way ofexample, printedmaterials orOn-Line.

Networkmeansany electronic system for communicating tomore than one PC andwhere such PCsare phys-
ically located in the samepremises, except as expressly providedherein.

On-Linemeanscommunicationsbymeansof the Internet orWorldWideWeb.
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PCmeansapersonal computer.

Softwaremeans, separately or together, the above-identifiedcomputer software.

Support Servicesmeansany serviceswhich SA International Inc. determines to provide in its sole discretion to
maintain the operation of the Software.

Youor Yourmeans you, any other entity on whose behalf youare acting, andanyonewho youor such entity
authorizes to use the Program.

LICENSE TERMS

The Software is protectedby the UnitedStatesCopyright Lawand International Treaties andother Intellectual
Property Rights. The copyrights in the Software shouldbe respectedby You just as Youwouldany other copy-
rightedmaterial, such asabook.

Youmaymake one (1) copy, in machine readable formonly, ofeach registeredcopy of the Software;
provided that each such copy is used solely for backuppurposes (i.e., for the purpose of reinstalling the Soft-
ware). As an express condition of this Agreement, if Youmake such acopy, acondition ofmaking that copy is
that Youshall reproduceandplace on any such copy SA International Inc.'s copyright notice andany pro-
prietary legendsas set forth on or in connection with the original copy orasappears ormay appearon anyOn-
Line sitemaintained for that purpose by SA International Inc. The right tomakeabackupdoes not extend to
anyMaterials.

Youmay transfer Your registeredcopy of the Software, but only with the assignment ofall of Your rights andoblig-
ations under this Agreement, to anotherperson or entity andonly accompaniedby acopy of this Agreement
andonly the originalMaterial accompanying the Software. Tomake this transfer Youand the party obtaining
the Software shall each first give SA International Inc. written orOn-Line notice of the transferwhich must
include that the person or entity has read, understands, agrees, andaccepts the termsandconditions of this
Agreement and further provided that You retain no copies of the Software or theMaterials.

Except as expressly provided in this Agreement, SA International Inc. does not grant Youany rights to patents,
copyrights, trade secrets, trade names, trademarks (whether registeredor unregistered), or any other rights,
franchises, or licenses in respect of the Software. Youwill not adapt or use any trademarkor trade namewhich is
likely to be similar to or confusingwith those of SA International Inc. or any of its suppliers or licensors or take any
otheraction which impairs or reduces the trademark rights of SA International Inc. or its suppliers or licensors.

Single-User License. If youhavepurchaseda single-user license of the Software, youare, by this purchase, gran-
teda limitednon-exclusive license to use the Software. If not already installedon aPC youmay install the copy
on that one (1) PC. Youmay access anduse the Software on that PC only.

If youare aprivate business, rather than an individual, authorizedpersonnel associatedwith the businessmay
use the Software, but only one (1) person at a timeandon that one (1) PC.

For your registeredcopy of the Software youmaymake one (1) backupcopywhich is restricted to your indi-
vidual use, for backuppurposes only, andonly for so longas the Software is installedon one (1) PC.

Multi-User License. If youpurchasedamulti-user license, youare granteda limitednon-exclusive license to (i)
use the Software on the numberof PCscorresponding to the number licensespurchased (but only one (1) per-
son may use the Software on one (1) licensedPC) andonly where all such PCsare ownedby you, (ii) make the
Software accessible through theNetwork so that each licensedPCmay use the Software, and (iii) makea
backupcopy of the Software for each license youhavepurchased. Youmay store, install, andaccess the
registerednetworkversion of the Software via theNetwork, andonly for each licensedPC that will ormay
access the Software. For example, if youwish to have five (5) different PCs (counting the server) access the Soft-
ware on theNetwork, each PCmust have its own paid-up license, regardless ofwhether or not any of the PCs
use the Software at different timesorat the same time.
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Youmay useOn-Line communications to operate the Software subject to the above termsandconditions and
further provided that youown each PC and that each PC has its own paid-up license. For example, if youare
communicatingbymeansofaPCOn-Line to another PC, each PC accessing the Softwaremust have its own
paid-up license.

Except as expressly providedherein, it is prohibited to give any copy of the Software to someonewhohas not
purchaseda license from SA International Inc.; to disclose interfaces to the Software, or to duplicate ordis-
tribute the Software by any othermeans includingelectronic transmission.

UNAUTHORIZEDDISTRIBUTION

The Software is protectedby copyright andalso contains trade secrets ownedby SA International Inc. Youshall
NOT distribute copies of the Software to others or electronically transfer the Software fromone PC toanother
overaNetwork, except as expressly provided in this Agreement. Youshall not modify, adapt, transfer, rent,
lease, loan, resell for profit, or distribute the Software, nor shall youdecompile, reverse engineer, disassemble
and/or otherwise reduce the Software to ahuman-perceivable formorcreate derivativeworks basedupon
the Software orany part thereof.

SUPPORT SERVICES

Use by youof Support Services is governedby SA International Inc.'s policies andprogramsdescribed in the user
manual, in documentation madeavailableOn-Line, and/or in other SA International Inc.-providedmaterials.
Any supplemental software codeprovided to youaspart of the Support Services shall be consideredpart of the
Software and subject to the termsandconditions of this Agreement.

INFORMATION

Youexpressly agree that SA International Inc.may use Information in its business, including for product support
anddevelopment. Youagree that SA International Inc.'s use of the Information is unrestrictedandnon-con-
fidential andYouautomatically grant SA International Inc., its successors andassigns, anon-exclusive, royalty-
free, worldwide, perpetual, irrevocable license in all Intellectual Property Rights in the Information, which
includes the unrestricted right to use the Information in any way SA International Inc. wishes, including, by way
ofexample andwithout limitation, to sublicense, copy, transmit, distribute, create derivativeworks, display and
perform. Youexpressly waive any claim to a right ofpublicity or right ofprivacy ormoral rights in such Inform-
ation.

TERMINATION

Without prejudice to any other rights, SA International Inc.may terminate theAgreement if you fail to comply
with any of its termsandconditions or if youviolate SA International Inc. "Acceptable Use Policy"which is pos-
tedupon SA International Inc. at www.saintl.biz, or such other internet-accessible location as SA International
Inc.may determine at its discretion. In such event, youshall destroy all copies of the Software (includingall of its
component parts) andMaterials. SA International Inc.may suspendordeactivate your use of the Softwarewith
orwithout notice. SA International Inc. reserves the right to discontinue all support for the Software. SA Inter-
national Inc. will endeavor to notify youofany such discontinuanceof such support but assumes noobligation
to do so. From time-to-time SA International Inc.may change the termsandconditions of this Agreement. Your
continueduse of the Software indicates youragreement to any such changes.

GOVERNINGLAWAND JURISDICTION

TheAgreement shall be governedby the lawsof the State ofUtah and jurisdiction for any dispute, except as
expressly providedherein, shall be exclusively within the courts locatedwithin the State ofUtah.

ARBITRATION

Any dispute arisingdirectly or indirectly underAgreement may, at SA International Inc.'s sole andexclusive dis-
cretion, be submitted to, and settledby arbitration by at least one (1) arbitrator. The arbitration shall be con-
ducted in accordancewith the rules for conductingarbitration by an organization previously established for
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conductingarbitration, which arbitration shall take place in Murray, Utah, or such other location in Utah asmay
bechosen by SA International Inc. Each arbitrator shall strictly apply Utah law, the Federal Rules of Evidence
and the termsof this Agreement and shall have nopower to strike, amend, ormodify said terms. Any such pro-
ceeding shall, at the exclusive discretion of SA International Inc. be held in confidenceby all parties andwit-
nesses. The judgment or the award renderedby the arbitrator(s)may be entered in any court having
jurisdiction thereofand there shall be no trial de novo. At the sole discretion of SA International Inc. the arbit-
rator(s)may have equitable powers including the right to issue temporary restrainingorders andpreliminary
injunctions.

PROPRIETARYRIGHTS

All right, title, and interest in and to the Intellectual Property Rights in the Software (including, without limitation,
any images, photographs, animations, video, audio,music, text, and "applets" incorporated into the Software),
theMaterials, andany copies of the Software are ownedby SA International Inc. except that which is owned
by its suppliers or licensors. Use ofany Intellectual Property Rights is restricted to the rights expressly licensed
herein andnone otherare granted.

DISCLAIMEROFWARRANTY

THE SOFTWARE IS PROVIDED "AS IS." SA INTERNATIONAL INC. AND ITS SUPPLIERSAND ITS LICENSORSDONOT AND
CANNOTWARRANT THE PERFORMANCEORRESULTSYOUMAYOBTAIN BYUSINGTHE SOFTWAREORSUCHFILES.
SA INTERNATIONAL INC. AND ITS SUPPLIERSAND LICENSORSMAKE NOWARRANTIES, EXPRESSOR IMPLIED, AS TO
TITLE OR INFRINGEMENT OF THIRD-PARTYRIGHTS, INCLUDING, BUT NOT LIMITED TORIGHTS IN INTELLECTUAL
PROPERTYRIGHTS, ANDMERCHANTABILITYORFITNESS FORANYPARTICULARPURPOSE.

IN NOEVENT SHALL SA INTERNATIONAL INC.OR ITS SUPPLIERSORLICENSORSBE LIABLE TOYOU FORLOST DATA,
LOST PROFITS, COST OFCOVEROROTHERANYCONSEQUENTIAL, INCIDENTAL,ORSPECIAL DAMAGES, EVEN IFA
REPRESENTATIVE OF SA INTERNATIONAL INC. HASBEENADVISED BYYOUOF THE POSSIBILITYOF SUCHDAMAGES
ORFORANYCLAIM BYANYTHIRD PARTY.

These limitations apply even if SA International Inc. or an authorizeddealer or distributor hasbeen advisedby
youof the possibility of such damage. SA International Inc. does not warrant any drivers for plotting, scanningor
otherdevices. Drivers are provided to youasa service only, andwere developedusing information provided to
usat the timeby equipment manufacturers.

SA International Inc. is not responsible for any typographical errors in the Software orMaterials.

SA International Inc. intends tomaintain Information in accordancewith SA International Inc.'s understanding
of industry practicesbut assumes no responsibility or liability in connection therewith.

This Agreement sets forth SA International Inc.'s entire liability andyour exclusive remedywith respect to the
Software and the use thereof.

This Agreement does not limit any rights that SA International Inc.may have under trade secret, copyright, pat-
ent, trademark, or other laws. No representative of SA International Inc. is authorized tomakeanymodification
to this Agreement, ormakeany additional representations, commitments, orwarranties bindingupon SA Inter-
national Inc.

INTEGRATION

This Agreement constitutes the full andcomplete agreement between the partieswith respect to thewithin
subject matter and supersedesall prior negotiations andagreements (whetherwritten or oral) between the
parties.

DEFINITIONSANDHEADINGS

The definitions providedherein are referred to herein by boldand italicization throughout this Agreement. The
definitions of such termsare understood to beapplicable to both singular andplural uses of such defined terms.
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The titles of this Agreement are inserted for convenience only and shall not be construedas limiting in anyman-
ner.

AMENDMENTS

Noamendment ormodification of this Agreement shall be validor bindingunless the same shall bemade in writ-
ingand signedon behalf ofeach party.

WAIVER

The failure to enforce any of the termsandconditions of this Agreement by SA International Inc. shall not be
deemedawaiver ofany other right or privilege under this Agreement or awaiver of the right to thereafter claim
damages for any deficiencies resulting fromanymisrepresentation, breach ofwarranty, or nonfulfillment ofany
obligation.

In order for there to beawaiver ofany termorcondition of this Agreement, such waivermust be in writingand
signedby the party making such waiver.

SEVERABILITY

If any provision of theAgreement is found invalidor unenforceable pursuant to judicial decree ordecision, the
remainderof this Agreement shall remain validandenforceable according to its terms.Without limiting the fore-
going, it is expressly understoodandagreed that each andevery provision of this Agreement that provides for
a limitation of liability, disclaimerofwarranties, indemnification or exclusion ofdamagesor other remedies is
intendedby the parties to be severable and independent ofany otherprovision and to be enforcedas such.
Further, it is expressly understoodandagreed that if any remedy hereunder is determined to have failedof its
essential purpose, all limitations of liability andexclusions ofdamagesor other remedies set forth herein shall
remain in effect.

GOVERNMENT REGULATIONS

If youare aU.S. Government end-user, this Agreement conveys only "RESTRICTED RIGHTS," and its use, disclosure,
andduplication are subject to Federal Acquisition Regulations, 52.227-7013(C) (1) (ii).

EXPORT REGULATIONS

Notwithstanding the location ofany PC herein, You represent andwarrant that, as requiredby theActs that,
unless Youobtain prior authorization from the UnitedStatesOffice of Export Administration, Youwill not know-
ingly re-export, directly or indirectly, nor knowingly allowany otherperson or entity to re-export, the Software
supplied for any purpose to any of the countries towhich such re-exports are prohibited. Your obligation here-
under is subject to theAct, which obligation shall survive the expiration or termination of this Agreement so long
as the relevant Act remains in effect.

ATTORNEY'S FEES

Should SA International Inc. prevail in any lawsuit, action, or proceeding in contract, tort, or otherwisewhich
arises out ofor related to this Agreement, SA International Inc. shall be entitled to recoverall of its costs and
expenses including, without limitation, its reasonable attorneys' fees incurred in connection with such lawsuit,
action, or proceeding, includingany appeal of such lawsuit, action, or proceeding.

SALESACROSS INTERNATIONAL BOUNDARIES

Asbetween the parties hereto, and in the sale anddelivery ofany goods, the UnitedNations convention
related to the sale ofgoods shall not apply to any sale ofgoodsdeemed toarise under in this or any otheragree-
ment between the parties.

©Copyright 2011 by SA International Inc., All rights reserved. Nopart of this publication may be reproduced,
stored in a retrieval systemor transmitted, in any formorby anymeans, electronic,mechanical, photocopy,
recordingor otherwise, without the priorwritten permission of the publisher. Printed in the UnitedStates of
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America. The information in thismanual is subject to changewithout notice anddoes not represent acom-
mitment on the part of SA International Inc.

The namesofactual companies andproductsmentioned in the Softwaremay be the trademarks of their
respective owners or their subsidiaries or affiliates andmay be registered in certain jurisdictions.
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1.3. SupportedApplications
OnWindows, CuttingMaster 4 supports the followingdesign applications:

CorelDRAWX4, X5, X6, X7, X8

Adobe Illustrator CS5, CS6, Creative Cloud

OnMacintosh OX, CuttingMaster 4 supports the followingdesign applications:

Adobe Illustrator CS5, CS6, Creative Cloud
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1.4. Using the Software
To senda job to acutter usingCuttingMaster:

Create the job in the design application.

If desired, add registrationmarks to your design.

Open the Cut/Plot dialog.

Adjust the job properties in the Cut/Plot dialog.

Send the job to CuttingMaster 4.

Use CuttingMaster 4 to output the job to the cutter.
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CHAPTER2 Installation and Setup
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2.1. Recommended System Requirements
Before youbegin installing the software, read the hardware requirements below. For optimal performancewe
suggest that your systemmeet the recommended requirements. Aswith all computer software, systemswith
faster processors,more RAM, andgreater amounts of storage spaceallow youtoworkwith larger files andkeep
yourprocessing time to aminimum.

Windows Macintosh

Processor i3 or higher Intel

RAM 4GBor greater

Installation space 1GB

Operating System Windows7, 8 and 10 OSX10.7 or greater

Other Available Port for Output Device

Internet Connection
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2.2. Installing the Software onWindows

2.2.1. Before You Begin
Before you install the software, youshoulddo the following:

Install all of your design applications.

Install anyadditional drivers that are necessary for your cutters, such asUSBdrivers.

Set your cutter to operate in GPGLmode. See your cutter documentation for details.

2.2.2. Installation Steps

Full access rights are required to install this software. Be sure to log on toWindowsasan administrator account
member.

To install CuttingMaster 4:

Uninstall anyprevious version of the software.

Download and run the CuttingMaster 4 installer

Select the Setup language and then clickOK.

On theWelcome screen, clickNext.

Read and accept the Software License Agreement and clickNext.

Choose the Destination Folder the software will be installed into. ClickNext.

Select Featuresand ClickNext.

Select the Program Folder where the shortcut for the software will appear. Bydefault, a new folder will be created
for the product.

ClickNext to begin installing the software.

If you have Adobe Illustrator installed, you will be prompted for the location of the Plug-ins folder for each version
of Illustrator you have installed.

If necessary, clickBrowse and select the folder location.

Select Finish.

2.2.3. Steps to uninstall the software
Exit CuttingMaster 4 by selecting Exit from File menu.

In theWindowsControl Panel, double-click the Add or Remove Programs icon.

Select CuttingMaster 4 from the list and click the Change/Remove button.

In theWelcome screen, select Remove and clickNext.

ClickYes to uninstall the software.

CHAPTER 2│CuttingMaster 4 UserGuide 16



2.3. Installing the Software onMac

2.3.1. Before You Begin
Before you install the software, youshoulddo the following:

Install all of your design applications.

Install anyadditional drivers that are necessary for your cutters, such asUSBdrivers.

Set your cutter to operate in GPGLmode. See your cutter documentation for details.

2.3.2. Installation Steps

Full access rights are required to install this software. Be sure to log on toMacOSXasan administrator
account member.

Follow these steps to install the software:

Download the installer

Double click the Installer icon.

Select a language and then clickOK.

Select the product and language to be installed and then clickOK.

Read the Software License Agreement and clickAccept.

ClickNext.

Select the Install Location and click Install.

The software installs. ClickStop to halt installation.

ClickYes to clear the preferences.

ClickOK.

ClickQuit.

2.3.3. Steps to uninstall the software
Exit CuttingMaster 4 by selecting Quit from the applicationmenu.

In the CuttingMaster folder, double-clickUninstall.

ClickOK.
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2.4. Creating an SAi CloudAccount
The first time you launch CuttingMaster 4, the SAiCloudConnect dialogcomesupallowing you to sign in with
an existingaccount or to sign up to anewaccount.

If you alreadyhave an SAiCloud account, enter in your email addressand password

If you are new to SAiCloud, ClickNeed an account? Sign Up

Enter in a valid email addressand clickSign Up

Check your email inbox for an email from noreply@saicloud.com

Follow the instructions in the email to create a password

Use the email and password you created to log into SAiCloud Connect
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CHAPTER3 Creating the Job in the Design
Application
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3.1. Guidelines for Creating Your Design
When creatinga job, remember the followingguidelines:

Convert all bitmap graphics into vector objects. CuttingMaster 4 can only output vector objects.

Objects cannot have patterned fills, bitmap fills, lenseffects, gradients, or other custom fill types. Anyobjectswith
these fill typeswill be ignored byCuttingMaster 4, and will not appear in the Cut/Plot dialog.

Use colors or layers to separate objects that you want to output at different times. You can then use the Layering
tab of the Cut/Plot dialog to choose which colors or layerswill be output.

There is no need tomake duplicate copiesof your design in the design application. CuttingMaster 4 can easily out-
put duplicatesof anydesign, and can even placemultiple copieson the same page.

Don’t worry about objects of the same color that overlap. The Auto-Weld feature can automaticallymerge over-
lapping objects together.

If you need tomakemultiple cutting passes, you can select the number of passes in the Advanced tab of the
Cut/Plot dialog. There is no need to stackupmultiple copiesof an object to forcemultiple cutting passes.
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3.2. Accessing the CutPlot Dialog
To access theCuttingMaster 4 Cut/Plot dialog:

If you are using Adobe Illustrator, from the File menu, select CuttingMaster 4 then Cut/Plot.

If you are using CorelDRAW, select Cut/Plot from the CorelApplication Launcher. The CorelApplication
Launcher is a list in the standard toolbar that lets you launch other applications fromwithin CorelDRAW.
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3.3. Entering Numerical Values
CuttingMaster 4 supports anumberofunique features that make it easier to enter numerical values.

3.3.1. Using Built-In Mathematical Operations
The software is able to performanumberofcalculationswheneveranumerical value is beingentered.

3.3.2. Automatic Unit Conversion
If youenter avalue usingadifferent unit ofmeasurement than the default unit, the softwarewill automatically
convert the value to the default unit.

For instance, if yourdefault unit is inches, youcan enter avalue of 1 ft, and the softwarewill convert themeas-
urement to 12 in.

Supportedunits are:

in, " inch

ft, ' foot

mm millimeter

cm centimeter

m meter

pt point

3.3.3. Calculation of Ratios
If youenter a ratio in the format A:B, the softwarewill scale the previous value in the fieldby the ratio entered.

For instance, if a value is set to 12, andyouenter 2:3, the new valuewill be 8.

3.3.4. Calculation of Percentages
If youenter apercentage in the format X%, the softwarewill scale the previous value in the fieldby the per-
centage entered.

For instance, if a value is set to 10, andyouenter 90%, the new valuewill be 9.

3.3.5. Simple Arithmetic Operators
If youenter a simple arithmetic expression, the softwarewill calculate the result of the expression andenter that
value in the field.

The available arithmetic operators, in order ofprecedence, are:

/ Division

* Multiplication
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- Subtraction

+ Addition

For example, if youenter 1/8, the value 0.125will be calculated.

Operator precedencedetermines the order in which the arithmetic operationswill be calculatedwhenmore
than one operation is specified. In the previous list, operators are listed from top to bottom in order ofoperator
precedence. For instance, if youenter 6/2*3, the softwarewill calculate 6/2 first then multiply the result by 3,
yieldinga result of 9.

3.3.6. Automatic Application of Entered Values and Arithmetic
Once youenter anumerical value, ratio, or arithmetic expression in anumerical field, the softwarewill auto-
matically apply that value after abriefdelay.
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CHAPTER4 Using CutPlot

CHAPTER 4│CuttingMaster 4 UserGuide 24



4.1. Sending Jobs to CuttingMaster
To send the current job toCuttingMaster 4 for output, click the Sendbutton in theCut/Plot dialog. To exit the
Cut/Plot dialog, clickDone.

Once sent toCuttingMaster 4, the jobwill immediately be output, unless the Hold in List option on theGeneral
tabof theCut/Plot dialog is checked. If Hold in List is checked, the jobmust be output manually. See “Out-
putting Jobs fromCuttingMaster 4”page 19 for details.

Once output, the jobwill either be deleted, or held in the queue, dependingon theAfterOutput setting in the
Advanced tabof theCut/Plot dialog.
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4.2. Setting Job Properties
The followingcontrols are available on all tabs of theCut/Plot dialog:

Properties Click to adjust the setup properties
Click to start CuttingMaster 4.

Click to select the Select tool. (This tool is selected bydefault most of the
time)
Click to select the Zoom tool. Click and drag in the job preview pane to
select an area of the design to zoom in on. For Windows, hold the CTRL
keyand click to zoom out. For Macintosh, hold the Option keyand click to
zoom out.
Click to select Zoom toWidth. The preview pane will automatically zoom in
or out so that the entire width of themedia is displayed.
Click to select Zoom to AllObjects. The preview window will zoom in or out
so that all of the objects in the design are displayed.

Reset Click to return job properties to their default settings.
Send Send the job to CuttingMaster 4 with the current settings.
Done Close the Cut/Plot dialog and return to the design application.
Save to File Saves the cut job asa file.
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4.3. General Tab Properties
TheGeneral taballows you to specify the size ofmedia, size of the joband the location of your output on the
media.

The following settingsare available:

Media Size The size of themedia loaded into your output device. Select from one of the preset
sizes, or specify unique dimensionsbelow.
Poll Size polls the size of themedia loaded in the cutter. This feature only

works if the device and port support bi-directional com-
munications.
The width and height of themedia.When a set of unique dimen-
sions is specified, it is automatically added to the list of preset
sizes.

Job Size Choosing one of these optionsallowsyou change the output size and orientation of the
page.

The job'swidth and height.
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The job'swidth and height asa percentage of the original.

Fit to Media Scales the job proportionally so that it is as large aspossible
while still fitting within the cuttable area of the output media.

Proportional When this option is selected, the height and width of the job are
increased or decreased together to keep the original pro-
portions intact.

Position These settings change the position of the job on themedia.
The distance between the job and the right and bottommar-
gins of the cuttable area. You can also change these settings
bydragging the job across the page in the preview pane.
Interactive: moves the cutter as you change the position of the
job on the preview area.
Showme: drawsa bounding boxof the job without lowering
the tool.
Places the job at the specified distances from the lower and
right edgesof the cuttable area of the output media.
Centers the job along the width of the cuttable area.

Centers the job in themiddle of the cuttable area. Only avail-
able for sheet material.
Rotates the image on themedia in 90-degree increments.
Click the button until you achieve the desired orientation.
Flips the selected image on the vertical axis, so that your image
will bemirrored when output.

The number of copies to be output.

The amount of space that will exist between the various tiles and/or copieshorizontally.

The amount of space that will exist between the various tiles and/or copies vertically

Selection Only Output only the selected objects, not the entire design. This option is enabled if you had
objects selected when you opened the dialog.

Repeat Job Sends the same job again for the number of times specified.
Hold in list If checked, the job will be held in the CuttingMaster 4 queue instead of being auto-

matically output. The jobmust be output manually fromCuttingMaster 4.
Use document ori-
gin

If not checked, left bottom point of the bounding boxof selected objects becomesorigin
of plotter. If checked, document origin of Illustrator or CorelDRAWbecomesorigin of
plotter. Positionsof objects from document origin are kept positions from the plotter ori-
gin. Note: Document origin of Illustrator or CorelDRAW is the point (0,0) of the ruler.
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4.4. Layer Tab Properties
The layering taballows you to assign different cuttingparameters to different color or layers in your cutting job.
Youcan cut one color slower than another color, for instance.

The following settingsare available:

By color/ By layer Orders your output by color, or by layer. “Layer” refers to layers in the design applic-
ation, not overlapping layers of vinyl.

If you choose Bycolor, all objectswith the same color will be cut at the
same time, unlessPausesbetween colors/layers are checked. If you have
overlapping objects of the same color, you will get overlapping contour
cuts.
If you chose By layer, the job will be cut one layer at a time. All objects in
each layer will be cut at once, unlessPausesbetween colors/layers are
inserted. If you have overlapping objects in a layer, you will get over-
lapping contour cuts.

There will be no pause between this color or layer and the next
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Output will be paused between this color or layer and the next. This allowsyou to
load different colored vinyl into your cutter.

Group Layers or colors
by driver options

If selected, the groupsor layerswith the same conditionswill be sent together.

Enable driver options Check to set the following options in the software. If this option is not checked, the
settingson the output device will be used instead.
Settings can be set individually for each color or layer by selecting the color or layer
in the list then setting the optionsbelow (but see Single setting for all).
Single setting for all If this option is checked, identical driver

optionswill be used for all colors or layers.
Preset Driver option presets allow you to save all of

the driver options for a common type of job
and reapply them in a single step.

Condition The cutter condition number. Numbers
range from 1 to 8. See the documentation
for your cutter for details on which numbers
are valid.

Speed Speed at which the cutting head or pen
movesacross themedia. Set to 0 to use the
setting on the cutter.

Force The amount of downwards force applied to
the cutting head or pen. Set to 0 to use the
setting on the cutter.

Quality TheQuality setting really controls themax-
imum acceleration of the cutting head or
pen. Lower settingsproduce higher quality,
at the cost of increased cutting time. Set to 0
to use the setting on the cutter.

Line Type Select the line type. The following line types
are provided as standard:

You can also edit custom line typeswith the
Custom Line Editor

Pitch Size The length it takes for the line pattern to
repeat when a line type other than solid is
selected.

Passes Defines the number of times that the blade
will cut the same path. Set this option if you
are using thick or hardmedia that can’t be
cut in a single pass.
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Plotter Controller If checked, CuttingMaster 4 will send the current job to the GraphtecPlotter Con-
troller application for output when the Send button is clicked. This option is only
enabled if the setup is for a device that is supported by the Plotter Controller applic-
ation. The device setupmust use a USB connection. If Plotter Controller is not
installed, this option will be disabled. See the Plotter Controller documentation for
details on outputting jobs from that application.When this option is checked, the fol-
lowing fields in the cut/plot dialog will be disabled:

Job width

Job height

Percent width

Percent height

Fit to media

Proportional

Copies

Copy spacing

Use registrationmarks

Hold in list

After output
In addition, the Rotation controlwill be limited to the 0 and 90 degrees coun-
terclockwise settings
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4.5. EditingCustom Line Types

4.5.1. To Add a New Custom Line Type
Select Custom Line Editor from the Line Type list

2. Select one of the 3 custom line types.
Custom 1 : The length of the first segment in the line.

Custom 2 : The length of the space between line segments.

Custom 3 :The length of the second and third line segments, if any. Custom 1 ismade up of one repeating
line segment, while Custom 2 has two segments that repeat in a pattern, and Custom 3 has three.

3. Edit the length of the line segments in the corresponding fields

ClickAdd to Save the new Line type

Enter a Name for the custom line type

ClickOK

4.5.2. To Modify an existing Custom Line Type:
Select the Custom Line from the list

Modify the settings for the line type

ClickSave

4.5.3. To Remove a Custom Line Type
Select the Custom Line from the list

ClickRemove
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ClickYes

4.5.4. To Export a Custom Line Type
Select the Custom Line

ClickExport

Browse for a location to save the file

Enter in a File Name

ClickSave

4.5.5. To Import a Custom Line Type
Click Import

Browse for the .xml file and clickOpen
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4.6. Panel Tab Properties
The Panel taballows you to split a jobup into anumberof smaller tiles that are then output separately

Panel Size The panel is the part of the job that will be split up into tiles and output by the software. If the
panel is reduced in size so that it doesnot cover the entire job, only the parts covered by the
panelwill be output.

Shows the width and height of the panel. To adjust, enter a
number or use the arrows.
The size of themargin. Themargin is the part of the panel that
extendsoutside of the boundaries of the job.

Selected Tile Selectswhich tile’swidth and height are displayed in the fields below.
Selects a tile to be edited. The selected tile is highlighted in the
preview pane.
Shows the width and height of the selected tile. To adjust,
enter a number or use the arrows.
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Output If checked, the selected tile will be output with the rest of the
job. If cleared, the tile ismarked with amesh overlay in the pre-
view pane, and will not be output.

All Tiles These settingsapply to all tiles and help you quickly set up automatic tiles, of equal size.
Selecting this option divides the job vertically into the number
of columnsspecified. Each columnwill be of equalwidth.
Selecting this option divides the job into the number of rows
specified. All rowswill be of equal height.
If you know that you want tiles of a certain size, enter the val-
ues for the width and height of the tiles here. All tileswill be
changed to the specified size.

Overlap Specifies the amount of overlap between rowsand columns. Byoverlapping, you can elim-
inate anygapsbetween the tileswhen assembling the final output. Overlap ismeasured as
the total amount two rowsor columnsoverlap.

Check to create an overlap on the vertical edgesof tiles.

Check to create an overlap on the top and bottom edgesof
tiles.
The width of the overlap. Enter a negative number to create
an offset between tiles.

Interleave Cop-
ies

In case of multiple copiesof tiled objects, this setting defineshow the tileswill be grouped

Interleave

No Interleave
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Sets the primary direction of
the panelmode to vertical.
This allows for the vertical tiles
to be split individually hori-
zontally

Sets the primary direction of
the panelmode to horizontal.
This allows for the tiles to be
split individually vertically.

Sets the panelmode to be
adjusted both horizontally and
vertically.
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Auto-tile A tile will automatically be created that includesall selected
objects. If no objects are selected, all of the objects in the
design will be included. If the design is too large to fit on the
selectedmedia, it will automatically be tiled so that each tile is
themaximum possible size. Auto-tile doesnot attempt to tile
the entire page, just the design or the selected objects.

Tile to Border The entire design page is automatically tiled. If the page is too
large to fit on the selectedmedia, it will be tiled so that each tile
is themaximum possible size.

Reset Resets all settings to their original state

CHAPTER 4│CuttingMaster 4 UserGuide 37



4.7. Dividing a Job into Tiles
The job starts as a single large tile that covers the entire job. This tile is selectedby default.

To divide the job intomultiple tiles, reduce thewidth and/or height of the first tile using the and fields in
the Selected Tile section. New tileswill automatically be created to cover the exposedareasof the job.

For instance, to divide a30x25 job into two vertical tiles, set the field to 15, reducing the size of the first tile to
15x25. A second15x25 tile will automatically be created.

4.7.1. Dividing a Job into Uniform Rows and Columns of Tiles
To divide the job into a specifiednumberofuniform rowsandcolumnsof tiles:

Check or to tile the job vertically or horizontally.

Enter the number of columnsof tiles in the field.

Enter the number of rowsof tiles in the field.

Set the amount of overlap between the tiles in the field.

4.7.2. Dividing a Job into Uniform Tiles of a Specified Size
To divide the job into uniform tiles ofa specified size:

Check and to set all tiles in the job to be of the specified size.

Set the and fields to the width and height desired for the tiles.

Set the amount of overlap between the tiles in the field.
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If the specified tiles do not cover the job evenly, the tiles at the top and right edgeswill bemade small enough to
fit in the gap.
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4.8. Selecting a Tile

To select a tile, either clickon the tile in the previewpane, or select the tile using the field in the Selected
Tile section of the Tile tab.
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4.9. Editing Tiles

To edit the size of the selected tile, change the values in the and fields.

Youcan also resize tiles by dragging their edges in the Preview Pane.

If anyof the All Tiles checkboxesare checked, the and fieldsmaybe disabled. In this case, the fields
have been overridden in order to keep all tiles uniform. The tileswill not be editable using the Preview Pane
either.

If youdrag the edgesof the panel over so that part of the job is exposed, anew tilewill be created to cover the
exposedareaof the job. The exception to this is if you resize the panel using the croppinghandles.
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4.10. Cropping a Job
To cropout part ofa job so that it will not be output:

Open the Job Properties dialog for the job.

Select the Tiling Preview view of the job.

Drag the red cropping handles so that the unwanted parts of the job are cropped out.

Cropped-out areas of the jobwill not be output.

Youcan also cropa jobby reducing the panel size using the , and fields in the Panel Size section of
the Tile tab.
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4.11. Advanced Tab Properties
TheAdvanced taballows you to set several options specific to cutting jobs.

The following settingsare available:

Advance after plot Advances themedia after the job hasbeen output and resets the ori-
gin.

Cross cut If checked, after a job hasbeen cut, the cutter will slice across the out-
put media above the job, separating it from the rest of themedia still
in the cutter.
For amulti-page job, the cutter will do a cross-cut after each page in
the job.
This option is only enabled for cutters that support the feature
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Additional advance Advances themedia an additional amount after the job hasbeen out-
put.

Weed Border Cuts a border with the specified Panelmargin around all objects in
the selected color and layer.

The weed border is alwaysa solid line, regardlessof any settings in
the Layering tab.

Panel Margin The panelmargin used for the weed border.
Horizontal weed lines Addsweedlinesbetween linesof text (or objects).Weedlinesare

always solid lines, regardlessof the line settings in the Layering tab.
Vertical weed lines Addsweedlinesbetween characters (or objects).Weedlinesare

always solid lines, regardlessof the line settings in the Layering tab.
Optimize cutting order Select the order in which objects in the design will be cut:

None The objects are cut or plot in the
order theywere created

Speed Priority The objectswill be cut in an
order that maximizes cutting
speed.

Restrict Media Movement The objectswill be cut in an
order thanminimizes the
amount that themedia has to
move.

Auto-weld Removesoverlapping areasof objects that have the same color.
Convert strokes to outlines Selectswhether the strokeswill be cut separately asan object.
Cut page crossing When the output is split up over a number of pages, cut page cross-

ing will cut a line between 2 pages

Cut Page CrossingON Cut Page CrossingOFF
Units Specifies the units that will be used for measurements.
After output Setswhat will be done with the file after it is output. Select either

Delete or Hold.
Step size The number of stepsper unit length currently set on your cutter.
Divde Always cuts segments from the outside in
Cutting Direction Sets the direction in which objectswill be cut
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Original Maintains the direction that was
assigned in the design applic-
ation

Clockwise Overrides the assigned dir-
ection. All objectswill be cut
clockwise

Counter Clockwise Overrides the assigned dir-
ection. All objectswill be cut
counter clockwise

Reset Restoresall settings to their original state
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4.12. Preventing Tiles from BeingOutput
To disable a tile andprevent it frombeingoutput with the rest of the job, doone of the following:

Double-click on the tile in the preview pane.

Right-click on the tile in the preview pane.

Disabled tiles aremarkedwith ahash pattern.

Tomakeadisabled tile able to be output again, double-clickor right-click the disabled tile a second time.

One tile in each jobmust alwaysbe enabled. If you try to disable all of the tiles, one of the other tileswill become
enabledagain.
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4.13. RegistrationMarks Tab Properties
The options on this tabare only available if Registration Markswere added to the design first.

The followingparameters are available

Use Registration Marks If your design contains registrationmarks, this option will be enabled bydefault.
Number of copieshorizontally

Number of copies vertically

Spacing in between horizontal copies

Spacing in between vertical copies

Horizontal offset

Vertical offset
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Reverse-side Regis-
tration Marks

This option allowsyou to cut out the registrationmarkson the printed side so they
can bemeasured when cutting the back side. This is necessarywhen cutting a box
for example, where certain pathsneed to be scored from the back.
Cut Surface
Cut back Side (Low Volume Pro-
duction)
Cut back Side (High Volume Pro-
duction)

Return to Scanning
Base Point after Plot

Moves the tool head to the base point after cutting.

Use previous the first
registration mark adjus-
ted with Base Point

Performsa one-point reading on four-point registrationmarks

Use previous 4-point
Registration Mark
adjusted

Four-point registrationmarksare performed onthe first sheet. In case of cuttingmul-
tiple copies, only one-point registrationmarksare performed from the second sheet
onwards.

Cut segment by seg-
ment

Cuts all the objects in a segment before proceeding to the next segment.

Reset Resets all parameters to their defaults
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4.14. Workingwith Driver Option Presets
Driver option presets allow youto save all of the driver options for acommon type of joband reapply them in a
single step.

4.14.1. Creating Presets
To save the current driver options asanewpreset:

From the Preset list, select Save as.

Enter a name for the new preset.

ClickOK.

4.14.2. Updating Presets
To update the currently selectedpreset with the currently selecteddriver options, from the Preset list, select
Save.

4.14.3. Applying a Preset
To apply the driver options saved in apreset to the current job, select the preset from the Preset list.

4.14.4. Renaming a Preset
To renameapreset:

Select the preset you want to rename from the Preset list.

Select the Rename command from the Preset list.

Type in the new name and pressOK.

4.14.5. Deleting a Preset
To delete apreset:

Select the preset you want to delete from the Preset list.

Select the Delete command from the Preset list.

ClickYes.
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CHAPTER5 Outputting Jobs fromCutting
Master
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5.1. Basic Elements of CuttingMaster
The followingare the basic elements ofCuttingMaster :

1 Toolbar

2 Device Bar

3 Setup Bar

4 Job Area

5.1.1. Column Headings
Job Name The file name of the job
Status The current statusof the job.
Copies The number of copies to be out-

put.
File Type The type of job.
Color The color specified for themater-

ial. If multiple colors are specified,
this field will readMultiple.
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5.1.2. Toolbar
A toolbar is locatedat the topof themain window. It contains tools for themost commonly used functions.

The toolbar functions are:

Add Job Addsa Adjob to the selected output device.

Send Job Sends the selected job to the output device.

Abort Stops selected file from being output.

Delete Deletes the selected job or jobs.

Help Opens theOnline Help
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5.2. Setting Application Preferences
To set application preferences, from the Edit menuselect Preferences.

The following settingsare available:

Units The units of measurement displayed
Precision The degree of precision to use with measurements
Disable submission of job
names and thumbnail
images to the cloud

Job Namesand Thumbnails are stored in your SAi
Cloud account so you can access them via tools
such as job reporting in the SAiMobile App.With
this checkbox you can disable sending those to
your Cloud account
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5.3. Creating anOutput Device
The output device setupprovides the linkbetween the software andyour output device. It contains the fol-
lowing information:

The type of output device being used.

Themethod used to communicate with the device.

5.3.1. Creating Your First Output Device Setup
When youstart the software for the first time, youare prompted to create your first output device setup:

Select theManufacturer andModelName of the output device from the list.

ClickNext.
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Edit the Setup name of the device.

Assign a unit ID number to your device. If you havemore than one cutter of the samemodel, thiswillmake it easier
to identifywhich cutter iswhich.

5. Select the Port the output device uses for communication. If necessary, edit the communications set-
tings for the chosen port.

ClickFinish

5.3.2. Editing Output Device Settings
To edit the properties associatedwith the output device setup, from the Setupmenu, select SetupProperties.
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Setup Name Name of the Setup
Set Unit ID
Update Unit ID

5.3.3. Changing the port of the Setup
To change the port ofaDevice Setup, doone of the following :

Select Change Device Port from the Setupmenu

Click the Arrow down on the left hand side of the device in the device toolbar and clickChange Port

Port Select the port to which the cutter is connected. The port list is limited to the ports that are actually
present on your computer and usable with your output device.
USB USBdrivers are provided with output devices that support them. Please

make sure the proper drivers are installed when using these ports.
TCP/IP If your cutter is connected via TCP/IP, enter in the IP addressof the cutter
COM Serial communicationsport. This port is supported by some of the older cut-

ter models.
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5.4. Outputting a Test Cut Job
The software allows you to output test cutting jobs to appropriate output devices, tomake sure everything is
functioningproperly.

To output a test cut job, from the Setupmenu, select Test Cut.
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5.5. Outputting Jobs
If the Hold in list box in theGeneral tabof theCut/Plot dialog is not checked, jobs that are sent toCutting
Masterwill be output automatically as soon as they are received.

If Hold in list is checked, the jobwill stay in the queue until yououtput it manually.

5.5.1. Saving a Job to a File
To save a job to a .PLT file, do one of the following:

Right Click the Job and select Save As

Select the job and choose Save As from the File Menu

Change the Port of the device to File.With this option, all jobs sent to the device will be saved to a file instead of
being output.

5.5.2. Loading a Saved Job from a File
To loadapreviously-saved job froma file:

From the File menu, select Add Job.

Select the .plt file to beadded.

If you want to copy the file to the local job folder, checkCopy to job folder.

ClickAdd

5.5.3. Sending Jobs to the Cutter
To senda job to the cutter, do one of the following:

Select the job and from the File menu, select Send.

Select the job, then click on the Send button in the toolbar.

Right-click the job and select Send from the context menu.

5.5.4. Aborting the Processing of a Job
To abort the processingofa jobwhile it is beingcut, do one of the following:

Select the job and from the File menu, select Abort.

Select the job, then click on the Abort button in the toolbar.

Right-click the job, then select Abort from the context menu.

5.5.5. Deleting Jobs
To delete a job, doone of the following:

Select the job and press the Delete or Backspace keyon your keyboard.

Select the job and from the Edit menu, select Delete.

Select the job, then click on the Delete button in the toolbar.

Right-click the job, then select Delete from the context menu.
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CHAPTER6 Contour Cutting Using Cutting
Master
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6.1. Adding RegistrationMarks Automatically
If no object is selected, CuttingMasterwill automatically add registration marks aroundyourdesign.

To add registration marks to yourdesign:

Open your job in the design application.

Access the RegistrationMarksdialog using one of the followingmethods:

In Adobe Illustrator, from the File menu, select CuttingMaster 4 then Registrationmarks.

In CorelDRAW, select RegistrationMarks from the CorelApplication Launcher. The CorelApplication
Launcher is a list in the standard toolbar that lets you launch other applications fromwithin CorelDRAW.

Select the desired registrationmark from the topmost list.

Set the necessary parameters and clickOK

The followingparameters can be set :

Units The unit of measurement.
Margin The distance between the registrationmarksand the job.
Thickness The thicknessof the line that makesup the registrationmarks.
Length The size of the registrationmarks, measured along one side.
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X Step This option is only available when Segment Area RegistrationMarksare selec-
ted. This controls the distance from one segment mark to the next.

X Direction Set which side of the page will be considered the X access. Thiswill affect
where the barcode will be added.

Convert Rectangle If checked, the registrationmarkswill be placed around the border of the selec-
ted rectangle. The rectangle will then be deleted, leaving only the registration
marks.

Relative to Page Relative to Page creates the RegistrationMarks relative to the edge of a
page,instead of to objects.

Align document origin with
Registration Marks

If checked, left bottom point of the registrationmarksbecomes (0,0) point of
ruler of Illustrator or CorelDRAW. If add the registrationmarkswithout check
this checkbox, move the (0,0) point of ruler to left bottom point of the regis-
trationmarksbefore send the job to cutter.

Use Reversed Color Regis-
tration Marks

If checked, the registrationmarkswill be white with a black square around
them.
Margin Specify themargin for the square around the registration

mark
Size Displays the final size of the reversed color registrationmark

Use Barcode Enable Barcode. This prints a barcode along with the registrationmarks
Barcode Length Choose the length of the barcode.
Keep Registration Marks Arrange the barcode without change the spacing and shape of the registration

marks.
Note Add text to be printed with the barcode. Themaximum length is 35 ASCII char-

acters
Barcode Link Info Displays the barcode link info. This is the number that is recognized by the cut-

ter when cutting the page
Use Trim Marks for the
Registration Marks

Check this option if you are using pattern3 registrationmarks, which are either
Japanese orRoman style. Trimmarkshave to be addedmanually.

Scan Mode Select the inclination adjustment that hasbeen set on the cutter
Spacing Specify the distance betweem registrationmarks.
X Reg Marks Distance Specify the distance between the registrationmarks in the X direction
Y Reg Marks Distance Specify the distance between the registrationmarks in the Y direction
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6.2. Contour Cutting
CuttingMaster allows you to use acutter to cut acontour on printedoutput generatedon a separate printer.
This producesoutput similar to that ofahybridprinter/cutter device.

In order to cut acontour on aprinted job, youneed to do the following:

Create the design for the job in your design application.

Add registrationmarks that will allow CuttingMaster to align the cut contour with the printed job.

Output the printed parts of your design.

Load the printedmedia into your cutter.

Output the contour part of your design on your cutter.
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6.3. Cutting the Job
To output the contour cut part of yourdesign:

Hide the layer or layers that contain the printed part of your design.

Make sure the layer or layers that contain the contour cuts are visible.

Use the Cut/Plot dialog to send the output to CuttingMaster.

Send the cut job to the cutter fromCuttingMaster, if necessary.
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6.4. Designing a Job for Contour Cutting
When designinga job for contour cutting, themost important thing is that youshouldbeable to separate the
printedparts of the job from the cut parts of the job.

This can bedone in twoways:

Byplacing printed and cut elements on separate layers and then hiding the layers you do not want to output.

Bymanually selecting the elements you want to print or cut, and then printing or cutting only the selected ele-
ments.

Of these twomethods, we recommendusing separate layers to isolate printedandcut elements, as thisworks
much betterwith complexdesigns.

6.4.1. Adding Registration Marks
TheCuttingMaster plug-in allows you to add registration marks to yourdesign. These registration marks can
then be used to align acontour cut with the printedoutput.

The registration marks are added in their own separate, locked layer of the design.

Do not change the name assigned to the layer containing the registrationmarks.

The registration marksmust be printedout in order to be used for automatic alignment ofacontour cut. The
marks themselveswill not be contour cut.

There are twoways to add registration marks to adesign:

Adding registrationmarksautomatically.

Adding a rectangle to the design and replacing it with registrationmarks.
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If the design is changed or resized after the registrationmarksare added, you will need to remove the regis-
trationmarksand add them again in order to properly indicate the new size of the job. Registrationmarksdo
not automatically update when a job is edited or resized.
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6.5. Loading the PrintedMedia into Your Cutter
Once the printedparts of the jobhavebeen output, allow the ink to dry (if necessary), then remove themedia
from the printer and load it into your cutter.

Be sure to orient the printedmedia so that the registration marks are not upside down, as this can cause prob-
lems.`

On aFlatbed type ofcutter

On a roll cutter

Load themedia into the cutter then position the headover the registration mark locatedat the bottom right
cornerwhen facing the cutter.
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6.6. Printing the Job
To output the printedparts of the design:

Hide the layer or layerswhich contain the contour cuts.

Make sure the layer or layerswhich contain the printed part of the design are visible.

Use the standard printing function of the design application to send the job to your printer.
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6.7. Removing RegistrationMarks
To remove the registration marks, do one of the following:

Repeat the procedure used to add themarks, but select None.

Unlockand delete the layer that contains the registrationmarks.
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6.8. Replacing a Rectangle with RegistrationMarks
If a rectangle is created in the design application, and is selectedwhen the Registration Marks dialog is
opened,CuttingMaster 4 can use it as aboundingbox for the registration marks. The registration markswill be
placedon the border of the rectangle, and then the rectanglewill be deleted, leavingonly the registration
marks.

To replacea rectanglewith registration marks:

Open your job in the design application.

Draw the rectangle that you want to use asa bounding box.

Access the RegistrationMarksdialog (see previous instructions).

Make sure the Convert Rectangle option is checked.

Set anyother desired options (see previous instructions).

ClickOK.
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